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This page contains Release Notes for older updates for StrataMax. This could be helpful for clients who would
like to know when a specific enhancement or change was introduced to StrataMax

StrataMax Version 5.6

StrataMax v5.6.79 Released Thursday 4th May
Building Information | New Options
Building Information screen now includes the ability to select, preview and delete a CMS document.

Unpresented Payments and Receipts Report

Unpresented payments and receipts are now managed separately, to assist with improving the processing
speed of daily banking. With this change a new menu Unpres. Payments and Receipts has been introduced as
well as a Security option and a newly titled report for inclusion in Report Set. There are also a new columns for
the Account Code and Account Name added to the Dashboard items No.Days Oldest Receipt Remains
Unpresented and No.Days Oldest Payments Remains Unpresented.

What's Better
An additional 3 enhancements have been included in this update. Please open the release notes and see the last
page for details on each.

Building Transfers - Version 5.6.79 is not backwards compatible and Building Transfers from 5.6.79 to pre-79
clients will not be available.

StrataMax v5.6.78 Released Thursday 20th April

EFT Manager | New Validation

If a payment is excluded or reversed outside of EFT Manager and EFT Manager has a batch loaded, the exclude
and reverse options are available and can still be used. Enhancements have now been made to validate when
the exclude or reverse options are selected and the batch has a payment that has been reversed or excluded
while having the EFT Manager window active, the user will be advised that the batch needs to be reloaded.

Building Information | Meeting Details
Changes have been made to the Meeting Details output to spreadsheet, the output will now include meeting
dates, times, and meeting details.

Bank Account Setup | Enhancements
Changes have been made in Bank Account Setup to make the ‘Remove’ button more obvious and add a tool tip
to assist users.
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Process Bank Statements | New Remove Option
A new option has been added to the Process Bank Statements screen to remove closed bank accounts where
reconciliations have been completed.

What's Better
An additional 6 enhancements have been included in this update. Please open the release notes and see the last
page for details on each.

StrataMax v5.6.77 Released Thursday 6th April

NSW Strata Hub | AGM Meeting Dashboard Report

A new Dashboard tile has been created to show buildings where reporting has exceeded the configured
threshold since the building's last AGM date.

All Bank Accounts | New Columns
New columns have been added to the 'All Bank Accounts' screen, which will allow users to export more
information.

All Bank Accounts | New Security permission
A new permission has been added to Security Setup, called ‘Search Bank Accounts’ that controls access to the
‘All Bank Accounts' screen.

New icon | Search Bank Accounts
A new icon and menu item has been added called ‘Search Bank Accounts’. This will display the same the 'All
Bank Accounts' screen in Bank Account Setup.

Bank Reconciliation | Automate Create Bank Transfers
A new option has been added when creating a legend in Bank Reconciliation, that would help identify potential
transfer between accounts and process them automatically.

What's Better
An additional 7 enhancements have been included in this update. Please open the release notes and see the last
page for details on each.

StrataMax v5.6.76 Released 23rd March 2023

Bank Account Setup | Account Type selections

Enhancements have been made to Bank Account Setup to include on-screen notes for the account type
selections as well as a new 'Status' column. An 'Other Investment Account' radio button has also been added to
replace the old 'Manual' tick box for when statement files are not available and manual reconciliation is required.

Bank Reconciliation | New Configuration setting
A configuration setting has been added to the Bank Reconciliation configuration called '‘Bank to Bank Transfer
Date Tolerance'. This will assist with managing bank transfers sent the next business day.

What's Better
An additional 5 enhancements have been included in this update. Please open the release notes and see the last
page for details on each.
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StrataMax v5.6.75 Released 9th March 2023
Automatic Month End Rollovers
Enhancements have been made to Automatic Month End Rollovers to check investment and operating accounts.

Process Bank Statements
Buildings that have the Manual Entry box ticked in Bank Account Setup will now be identified in the Process Bank
Statements screen.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see the last
page for details on each.

StrataMax v5.6.74 Released 23rd February 2023
Building Information | Office Bearer Mobile/Contact Details
Building Information screen now includes an extra column for the mobile number for committee members.

Roll/Plan Report
The Roll Plan Report has been reinstated and is now available in the Roll screen, in the Reports menu.

Security Setup | Creditor Invoices
A new security permission called ‘Creditor Invoices-Edit Description’ has been added. This controls a user's
access to change the description of any creditor invoices in the Payments Management screen.

Process Bank Statements | New Configuration
New configuration option called ‘Default Account Type Filter’ has been added to the 'Configuration’ screen in
Process Bank Statements.

Bank Account Setup | Import unregistered bank accounts

A new import option has been added to the Bank Account Setup screen for any bank accounts for banks other
than SCM (SCM already supported). The new options will appear for all banks that don't have a bank account
already set up. StrataMax detects this in the downloaded banking file.

What's Better
An additional 12 enhancements have been included in this update. Please open the release notes and see the
last page for details on each.

StrataMax v5.6.73 Released 9th February 2023

NSW Strata Hub - Report Externally

We have added a new field in Building Information for NSW Buildings called 'Report to Strata Hub manually'.
When set to 'Yes' the building will not appear in the NSW Strata Hub for upload.

Creditor Aged Balance Report
Creditors Aged Balances Report now has the additional selection of 'Creditor Code Order' and 'Creditor
Description Order' available to sort the report by Creditor Code or Description.

Roll Submissions

With the recent enhancements to the Roll Submissions, released on Portal (31st January 2023) will now by
default be displayed. Any historical unprocessed submissions, can be viewed from
\BCM\Archive\UnprocessRollsSubmissions.xIsx.


https://dyzz9obi78pm5.cloudfront.net/app/image/id/6407f1a64a5c4607bc2e331b/n/5675-patch-release-notes.pdf
https://smhelp.stratamax.com/help/month-end-rollover-main#automatic-month-end-rollover
http://smhelp.stratamax.com/help/bankaccountsetup
http://smhelp.stratamax.com/help/process-bank-statements
https://dyzz9obi78pm5.cloudfront.net/app/image/id/63f5797382e55c78a550b461/n/5674-patch-release-notes.pdf
http://smhelp.stratamax.com/help/building-information
http://smhelp.stratamax.com/help/roll-configuration-overview
http://smhelp.stratamax.com/help/payments-management
http://smhelp.stratamax.com/help/process-bank-statements
http://smhelp.stratamax.com/help/bankaccountsetup
https://dyzz9obi78pm5.cloudfront.net/app/image/id/63e2d1b1bcd27447e3773e0f/n/5673-patch-release-notes.pdf
http://smhelp.stratamax.com/help/building-information
https://smhelp.stratamax.com/help/creditor-reporting#creditors-aged-balances
http://smhelp.stratamax.com/help/rollsubmissions

Bank Account Setup and Investment Banking

StrataMax now has the ability to manage both operating and investment accounts at the same time in BCMax
and GLMax. This enhancement will streamline the download and reconciliation of investment banking, resulting
in improved balance verification, faster processing times, easier interfaces and new reporting.

Process Bank Statements
The Process Bank Statements screen is designed to give the users a central point to view and action daily
banking for all buildings, all banks and now investment accounts.

Global Bank Reconciliation Summary Report
The global report Bank Rec. Summary Report has been enhanced to support investment accounts to report bank
reconciliation information.

Security - Process Bank Statements/Bank Reconciliation
New Security Setup permissions have been added to allow users access to the new menus 'Process Bank
Statements' and 'Bank Rec. Summary Report'.

Dashboard - Maturing Investment Accounts
A new Dashboard item called 'Maturing Investment Accounts' has been added providing the ability to monitor
investment accounts maturity.

Transferring money between Operating and Investment Accounts

In the Bank Reconciliation screen a new Create Bank Transfer button is available to transfer funds between the
operating and investment account. The system will automatically reconcile between the funds for transactions
processed through the bank as 'Other or Interest'.

What's Better
An additional 6 enhancements have been included in this update. Please open the release notes and see page
27 for details on each.

Release Notes Roll Submissions Released 31st January 2023

Online Roll Submissions have been redeveloped to accommodate the changes made to the Roll in 2022. The
update of roll submissions will be released in two stages; stage 1 released on 31st January 2023 is activated for
all clients on v5.6.64 or higher. This stage is prioritised to allow roll submissions to be accepted for a lot that
includes multiple contacts. Please note in version 5.6.71 two additional configuration settings were added; click
here to view details.

StrataMax v5.6.72 Released 25th January 2023

What's Better

An additional 5 enhancements have been included in this update. Please open the release notes and see page 3
for details on each.

StrataMax v5.6.71 Released 117th January 2023
Creditors Aged Balances Report (formerly Creditors Balances) has been updated; Creditors List has been
removed, as was reporting similar information. Global reports have also been updated.
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What's Better
An additional 12 enhancements have been included in this update. Please open the release notes and see page
3 for details on each.

StrataMax v5.6.70 Released 5th January 2023

Process Bank Statements - Heritage Bank

Heritage banking files are now supported for both BCMax and GLMax, once banking files are downloaded
Process Bank Statements can be used to assist with importing and reconciliation.

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page 4
for details on each.

StrataMax v5.6.69 Released 21st December 2022

NSW Strata Hub Enhancements

We have added a new value, ‘Not Set’, to the NCC Building Class field in Building Information, as well as a 'Copy
Value to other buildings' button.

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page 4
for details on each.

StrataMax v5.6.68 Released 15th December 2022

Opening Balance Setup | Cash at Bank Unpresented Receipt

Enhancements have been made to Opening Balance Setup to create an unpresented receipt to the '012 Cash at
Bank' account code in Bank Reconciliation when entering the opening balances for a new building. The initial
deposit will present to this when processed into the bank.

Process Bank Statements | Drag and Drop Statement Files
Drag and drop functionality has been introduced for statement files copied to Process Bank Statements.

Bank Reconciliation | User Id
A new message has been added to the Bank Reconciliation noting when an item is created manually.

Delete Statement Files

Banking statement files can now be deleted after import if required. This option is to not store the banking files
once they have been imported, removing sensitive data from the file system. Further details can be located in
our Data Maintenance article.

Receipt Allocation | Overdue Interest
As per state legislation, overdue interest will now be posted before anything else if the 'Overdue Interest' levy
invoice code is the lowest priority in Levy Invoice Code Setup.

Bank Reconciliation | Configuration
Two new tick boxes have been added to the Bank Reconciliation Configuration screen so that payments will
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auto-process from owners who are in Legal Action, and/or owners who have a payment plan set up.

What's Better
An additional 7 enhancements have been included in this update. Please open the release notes and see page 7
for details on each.

StrataMax v5.6.67 Released 1st December 2022

Move Fund Balances

A new icon and screen titled Move Fund Balances is now available to allow correction of fund balances for an
account.

Strata Hub | NSW Integration

StrataMax has worked with the NSW Government to enable a bulk upload of the required data to the Strata Hub
Portal based on NSW Government validation requirements, and introduced a new icon and screen called NSW
Strata Hub.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 6
for details on each.

StrataMax v5.6.66 Released 17th November 2022

Meeting Hub | Distribution Enhancement

The Document Distribution screen has been enhanced to have the ability to further select the 'Mailout' options for
document delivery.

Contact Management | Agent & Correspondence Settings
Enhancements have been made to Contact Management to automatically update the roll when an agent is
withdrawn.

Totals Per Invoice
Enhancements have been made to 4 different screens to display a total per invoice, not just per payment.

What's Better
An additional 14 enhancements have been included in this update. Please open the release notes and see page
7 for details on each.

StrataMax v5.6.65 Released 1st November 2022

Stored Reports in DocMax | Merge Letters & Sub-Group

The second stage of this enhancements has been made to store all stored reports into DocMax, and now
includes .DOC Merge Letters and Sub-Group (Utility Billing) invoices and reports, which will allow users to view
these documents in Work Queues and upload them to the StrataMax Portal where applicable (lot specific
documents such as Levy Notices should not be uploaded to the portal). Please note this does not include
GLMax documents.

Receipting | Allocation by Due Date
Enhancements have been made to the Ul in Receipt Entry, Bank Reconciliation > Receipt, and Debtor
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Adjustments. It will now allow users to see the due date of each transaction including invoices not associated
with a levy fund.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 5
for details on each.

StrataMax v5.6.64 Released 20th October 2022

Building Information Redesign

Building Information has redesigned from the ground up and replaces the Info Update, Building Info and Building
Information menus into one screen. This redesign will provide users with an easier interface and introduces a
number of new features to allow customisation based on user & company requirements.

DocMax | Searchable Building Type and Regulatory Module Fields
New fields have been added to DocMax which will filter the documents returned by 'Building Type' and
'Regulatory Module'. These fields can also be included in Saved Searches and Work Queues.

New WA Building Type Options
We have added two new building type options for Western Australian buildings selectable in Building
Information and New Building (BCMax) screens.

Notes | All Areas
Note modules have been enhanced and now have a refreshed user interface. The new screen has been
implemented in any location that notes can be added in BCMax and GLMax.

What's Better
An additional 5 enhancements have been included in this update. Please open the release notes and see page
19 for details on each enhancement.

StrataMax v5.6.63 Released 6th October 2022

Meeting Hub | Update Minutes for Adjourned Meetings

When a meeting is adjourned and then reconvened, a manager should be able to send a consolidated version of
the minutes which includes details of both the adjourned and the reconvened meeting to owners. If a meeting is
adjourned multiple times, the details of all meetings should be included.

Enhancements have been made to document generation that is now capable of receiving a collection of
meetings and their associated template groups, instead of just one at a time. The document generation will now
join the merged documents for each of the meetings in the collection order that they are received from the
website.

What's Better
An additional 7 enhancements have been included in this update. Please open the release notes and see page 6
for details on each enhancement.

StrataMax v5.6.62 Released 21st September 2022
DocMax | Subgroup Selection
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The ability to select Sub Group buildings is now available in DocMax. Documents can be added to Sub Groups
buildings for Utilities, Marina buildings, By Law Sub Groups and Air Conditioning Sub Groups.

Meeting Hub | Change distribution method
The Document Distribution page has been enhanced to allow the user to change the distribution method for the
Recipients on the Recipients grid.

Meeting Hub | Keyboard shortcuts
Standard tag column behaviours have been added to the Meeting Hub Document Distribution page.

What's Better
An additional 6 enhancements have been included in this update. Please open the release notes and see page 6
for details on each enhancement.

StrataMax v5.6.61 Released 8" September 2022

Roll | Office Bearer Identification

Committee Members will now be identified in the Owner Details screen if they have been added to Office
Bearers from the Roll. 'Committee Member’ will be displayed regardless of the position held.

StrataCash Hub

StrataCash Hub has now been enabled for all clients with this update and is a direct replacement of the old
StrataCash menu. This new hub will streamline access and requests to the StrataCash team. The icon may be
located on your StrataMax Desktop or found using the StrataMax Search.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 4
for details on each enhancement.

StrataMax v5.6.60 Released 25™ August 2022

Contact Management | Merge Contacts

In the Contact Management screen, a confirmation prompt has been added and will appear when merging
contacts to allow review of the changes prior to proceeding.

New Building Setup | Add New Lots

When creating a new building with new lots, the date of the roll set up will default to the date of registration for
the building. Original Owners will be added as of that date if not modified at the time new lots are created. This
will allow the date of acquisition to be backdated if required.

What's Better
An additional 8 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement.

StrataMax v5.6.59 Released 11 August 2022

DocMax Merge Fields

We have created the ability to use Merge Fields for DocMax Title, Description & Notes fields and allow these to
be applied on profiles and action buttons of work queues.
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Edit Invoice Transaction Details | Debtor Transactions
Transaction descriptions can now be edited for debtor transaction with references that start with 'MQ' (Please
note that this does not include transactions with reference 'MA").

South Australia | Presiding Officer, Secretary and Treasurer

Enhancements have been made to BCMax to update the office held for presiding officer to be classified as a
chairperson. This change will allow committee elections for presiding officer, secretary, treasurer and ordinary
members in meeting hub for South Australia in the upcoming Online voting release.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 4
for details on each enhancement.

StrataPay Online DDR Released 8™ August 2022

Online form for Direct Debit Requests

With StrataPay’s online direct debits, owners can easily setup an automatic payment for their levy balance to
come directly from their bank account or credit card. Alternatively, they can set a scheduled fixed amount to be
drawn at a time and frequency that suits them. Refer to www.stratapay.com/levyddr or the release notes for
more information.

Setup a new Direct Debit Request online

Owner’s can simply go to our Direct Debit page where they can submit an online form that allows them to pay via
their Credit card, Debit card or Australian Bank Account. They will need their StrataPay reference number to
access the online form.

Amend or Cancel an existing Direct Debit Request online
Direct Debits can be amended or cancelled via our Direct Debit page.

StrataMax v5.6.58 Released 28th July 2022

Data Health Dashboard - Lost Building Documents

Further breakdown of documents by Lost/not-lost building status has been provided as an option in the Data
Health configuration screen.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 4
for details on each enhancement.

StrataMax v5.6.57 Released 14th July 2022

Bank Account Setup | Add Address

The following new options have been added to Bank Account Setup to select if the address for the bank account
will:

e Use building address as account owner.

e Use manager address as account owner.

Search Transactions (Edit Transaction Description/Details)
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The Quick Transaction List screen has been replaced with a new screen called Search Transactions, this will
allow users to search transactions and edit descriptions for specific transaction types.

Bank Reconciliation | Unmatch Allocation
A new option, ‘Unmatch this allocation’ has been added to the Bank Reconciliation screen. This new option will
allow users to Unmatch EFT's, cheques and receipts that were manually matched.

New Building Setup | Creating new lots in the Roll

The 'Add Lots Start' screen will now be presented when creating new lots in the building setup process. This is
so the plan date can be set to the appropriate Lot Effective date, (Date of Building Registration for example), at
the time the building is created.

What's Better
An additional 6 enhancements have been included in this update. Please open the release notes and see page 9
for details on each enhancement.

StrataMax v5.6.56 Released 30th June 2022

Process Bank Statements | St George

Enhancements have been made to import St George (STG) banking once banking files are downloaded daily
using Process Bank Statements .

What's Better
An additional 10 enhancements have been included in this update. Please open the release notes and see page
4 for details on each enhancement.

StrataMax v5.6.55 Released 16th June 2022

Roll Replacement

The Roll interface has been extensively enhanced to provide a clearer overview of lot details while maintaining
current functionality. The options have changed as most tools and options have now been incorporated into the
Roll screen. Essential options have been retained as menu items as well.

Contact Management

Contact Management has been designed to manage any contacts added to building records. At present it will
manage existing contacts or newly created contacts for an owner, tenant, agent, office bearer, nominee or other
representative contact.

Desktop Search
The desktop search bar has been enhanced and can now be used to search for contacts and lots based on

e Contact Name

e Contact Email Address
e 9-digit StrataPay number
e Lot Address Field

Roll Submissions | Icon and Dashboard Item
A tile to show unprocessed Roll Submissions is now available to add to the desktop Dashboard, and the Roll
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Submissions screen now has its own icon.

Transfer Agent Portfolio
The Transfer Agent Portfolio has been created to assist with the migration of records when some or all of a Real
Estate Agents portfolio is moving to a new Real Estate Agent.

Insurance Policy Expiry Notification
The Insurance Policy Notification message will now be displayed beside the building selector. The notification
will be based on the expiry date set for Insurance Code 901.

Office Bearers Report | Custom Sort Order
Office Bearer Reports can now be customised to display Office Bearers in any order.

Data Health Check | New Dashboard Item and Report
A new report item has been added to the Administrator Dashboard called Data Health to facilitate review and
configuration of building data file retention.

Process Bank Statements | Bendigo
Enhancements have been made to import Bendigo (BBL) banking once banking files are downloaded daily using
Process Bank Statements.

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page
29 for details on each enhancement

StrataMax v5.6.54 Released 2nd June 2022

BAS Configurations

Enhancements have been made to two settings in the configuration menu of the Business Activity Statement
screen.

Receipt Entry | Zero Receipts
Receipt Entry has been enhanced to no longer allow $0.00 amounts to be saved for receipts.

What's Better
An additional 3 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement

StrataMax v5.6.53 Released 19th May 2022

Process Bank Statements - ANZ

Enhancements have been made to import ANZ banking once banking files are downloaded daily, using the
Process Bank Statements screen.

Merge Letters - LoginIiDCheck field
We have exposed the "LoginIDCheck" field in Merge Letters to provide an option to produce Welcome Letters
with 9-digit StrataPay Reference numbers.

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement.
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StrataMax v5.6.52 Released 5th May 2022

Process Bank Statements - Import NAB and CBA

Enhancements have been made to import NAB and CBA banking once banking files are downloaded daily, using
the Process Bank Statements screen.

Levy Arrears - Option to list levy arrears in Due Date order
An option to show overdue levy arrears in due date order on arrears notices is now available in the Arrears Notice
configuration. When set, levy arrears will be ordered by due date rather than by Invoice code.

Meeting Hub - New merge fields for Document Generation
Two new merge fields have been added to the Committee Election template groups in Meeting Hub.

What's Better
An additional 7 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement.

StrataMax v5.6.50 Released 21st April 2022

Banking & Bank Reconciliation

This release includes a complete overhaul of the Bank Reconciliation screen. There are also two completely new
screens; the Bank Reconciliation Report and Process Bank Statements, which has been designed from the
ground up to streamline the download and reconciliation of daily banking.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page
19 for details on each enhancement.

StrataMax v5.6.48 @ Released 7th April 2022

Meeting Hub Enhancements

Collections of new merge fields have been added to the Meeting Hub and merge fields can now be filtered by
search text.

NOTE: Template Groups for minutes will need to be amended.

What's Better
An additional 5 enhancements have been included in this update. Please open the release notes and see page 4
for details on each enhancement.

StrataMax v5.6.47 @ Released 21st March 2022

GLMax Debtor Adjustment

Debtor Adjustment has been added to GLMax to allow users to easily reallocate funds for a debtor and funds
between debtors.

Invoice Hub I Creditor override for single layer approvals
Enhancements have been made in the Invoice Hub to allow a Creditor Override for a single layer approval.
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NSW StrataMax Hub Report

On the 30th June 2022, NSW legislation commences where managers will be required to input data into the
Strata Hub (an online government platform). Schemes will be required to lodge an annual return within 3 months
of the AGM. A link to the regulations is below. To assist with the collection of data required; a global report is
now available that reports information from Info Update, Insurance, Office Bearers, Inspections Register and
Account Balances. This report is called ‘NSW Strata Hub Report.’

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page
15 for details on each enhancement.

StrataMax v5.6.46 @ Released 10th March 2022

What's Better

An additional 9 enhancements have been included in this update. Please open the release notes and see page 3
for details on each enhancement.

StrataMax v5.6.45 @ Released 24th February 2022

DocMax - Account Group Field (Victoria Multi OC)

A new DocMax property has been added to accommodate documents added to DocMax for an account group
building where the document is specific to a particular Account Group.

Levy and Arrears Notices | BCC Account Manager
Emailed Levy and Arrears Notices can now be configured to BCC the building Account Manager that has been
set in Info Update.

Month End Rollover | Skip GLMax BAS Check
Month End Rollover in GLMax can now be configured to skip the check if the latest BAS has been saved for
GLMax companies where the BAS is not required.

Part 1 | Stored Reports storing in DocMax

Enhancements have been made to store all Stored Reports in DocMax, which will allow users to view these
documents using the various functions of DocMax (when the Roll changes are released, a shortcut from the lot
to that lots documents will also be available). This change will also aim to reduce the BCMax database size for
backups. Existing Stored Reports will not be initially moved to DocMax on upgrade - this will occur separately via
the scheduler over time; as this occurs documents that may seem old will appear in Recently Added. All reports
will still be viewable in Stored Reports.

What's Better
An additional 3 enhancements have been included in this update. Please open the release notes and see page 7
for details on each enhancement.

StrataMax v5.6.43 @Released 10th February 2022

Master Chart Filter | Delete Accounts

Account codes can now be be deleted from the Base Building using the Master Chart Filter and Header accounts
are now available for selection when deleting codes in the Base or any tagged building/s.

DocMax Work Queues | Slow Performance Indicator
We have added a 'Slow Performance Indicator' icon and 'Slow' note for Work Queues where performance may be
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impacted by the volume of data or configuration issues.

StrataCash Hub

StrataCash Hub is a direct replacement of the old StrataCash menu. This new hub will streamline access and
requests to the StrataCash team. The icon may be located on your StrataMax Desktop or found using the
StrataMax Search.

Please note that this will be activated on a client by client basis. The list of actions available on the hub may
differ from the list shown.

What's Better
An additional 8 enhancements have been included in this update. Please open the release notes and see page 7
for details on each enhancement.

StrataMax v5.6.42 @ Released 27th January 2022
Process Recoveries | Preview Summaries
A variety of different summary previews are now available when previewing unprocessed recoveries.

BCMax Email Server | notification for failed email
Notifications will now be sent to the sender of failed emails.

Office Bearers Report | Lot Fields
The Office Bearers screen has been enhanced to display the lot number and unit number for '‘Owner of Lot 'and
'‘Nominated By' columns.

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page
11 for details on each enhancement.

StrataMax v5.6.40 & Released 13th January 2022
Report Set | Include Extra Financial Reports
We have added the ability to include Extra Financial Reports in Report Sets.

Management Fees Setup | Increase by Fixed Amount
A new option to increase periodic values by a fixed amount has been added to Management Fee Increase
options.

DEFT Slip Changes
As required by Macquarie Bank, DEFT slips have had Australia Post wording updated to remove the cash
payment option. Bar codes have also been altered to remove the additional $2.75 adding to the total amount.

Financials Statements | Lot Budget Summary Report
The Lot Budget Summary Report has been added to Custom Report Templates where a custom template can be
selected for the report.

Office Bearer Report | Account Manager
The Office Bearers Report will now include the Account Manger contact details name, phone number and email
address if available.

What's Better
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An additional 6 enhancements have been included in this update. Please open the release notes and see page 9
for details on each enhancement.

StrataMax v5.6.39 @ Released 16th December 2021
Contact Card | Security Permissions
There are new security permissions for editing contact name, contact details and preferences.

Communications | Multiple windows
The Communications module will now allow users to utilise other modules and menu options when in the
Compose Email screen.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 6
for details on each enhancement.

StrataMax v5.6.38 @ Released 2nd December 2021

Office Bearer Report - 'Send Status Reports' field

The 'Send Status Reports' field on Office Bearer Reports will also observe the 'Officer Types' selected in Status
Report > Options > Set Officer Types.

What's Better
An additional 7 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement.

StrataMax v5.6.37 @ Released 18th November 2021

NSW Legislative Changes

The Community Land Management Act 1989 will be replaced by ‘Community Land Management Act 2021" on
1st December, 2021. On that date, all references to the old act need to be replaced by references to the new act.

https://legislation.nsw.gov.au/view/pdf/asmade/act-2021-7

Victorian Legislation | Building Tiers
From 1st December new legislation comes into effect where buildings will be classed under specific tiers based
on the Active Lot count, found in Info Update. This excludes lots marked as a 'Car Park’ or 'Storage'.

Office Bearer | Enhancements
We have added multiple enhancements to the Office Bearers screen. Please see page 5 - 9 for details.

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page
10 for details on each enhancement.

StrataMax v5.6.36 @ Released 4th November 2021

Office Bearers | Contacts

Enhancements have been made to the user interface when creating a new contact. Please refer to the Office
Bearers article for more information.
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What's Better
An additional 11 enhancements have been included in this update. Please open the release notes and see page
5 for details on each enhancement.

StrataMax v5.6.35 @ Released 19th October 2021

StrataMax Desktop | ResVu

We've added link to our new integration partner ResVu, who provide owners and tenants with the opportunity to
action all of their day-to-day needs directly from a custom-branded mobile app.

Add Office Bearer | Copy from Roll
The ‘Select from Roll’ button has been changed to ‘Copy from Roll’, which allows the contact to be modified and
saved as a separate contact to the Roll.

What's Better
An additional enhancement has been included in this update. Please open the release notes and see page 5 for
details.

StrataMax v5.6.34 &
Invoice Hub | Credit Notes
The Invoice Hub can now be configured to upload credit note invoices for approval.

What's Better
An additional 4 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement.

StrataMax v5.6.33 @ Released 7th October 2021

Account Dissection Report | Account Groups (Multi OC Buildings)

New options have been added to the Account Dissection report that allows selection of one or all account
groups to be reported separately.

Processing Standing Journals after Auto-Rollover Month End

Pending transactions may occur when the date of the transactions is in future of the current posting month, but
becomes current once the completion of the rollover has occurred. The Auto-Month End function will now
process any pending Management Fee and Recoveries transactions, automatically after it completes the
rollover.

Financial Reports | Old Presentation Financials

Old style Presentation Reports have been replaced with Presentation Style 2 Reports and will soon be removed.
If an old-style report is selected, a message will be displayed advising that the selected report will be retired in
future versions.

Meeting Hub | Email Template
Meeting Hub Email templates have been enhanced to provide meeting details in the email.

What's Better
An additional 6 enhancements have been included in this update. Please open the release notes and see page 8
for details on each enhancement.
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StrataMax v5.6.32 @ Released 23rd September 2021

Printer setup for Bing API

Enhancements have been made to allow either API or Mailroom to be selected in the Printer Setup screen
throughout StrataMax. A new option called ‘StrataMax Bing Easy Post API’ in the Printer can be selected if the
Bing Web API has been configured.

Office Bearers | Contact Management
Office Bearers has been redesigned with a new enhanced user interface, and integrates with the new Contact
Management system.

Manager Maintenance | Contact Management
Manager Maintenance has been redesigned with a new enhanced user interface, and integrates with the new
Contact Management system.

What's Better
An additional 11 enhancements have been included in this update. Please open the release notes and see page
17 for details on each enhancement.

StrataMax v5.6.31 @ Released 9th September 2021

BingMail API | Printing to EasyPost Mailroom

The BingMail Web API can now be used from any area when printing notices or documents in bulk, rather than
using the EasyPost Mailroom software. This will group and send documents or reports printed for each building
and quickly upload them to the BingMail portal for review. See Bing EasyPost & BingMail for more info.

Security Setup | Replicating User Settings

Through the Security Setup menu, we have added the ability to copy user settings from one StrataMax user to
another. The option ‘User Settings’ will allow the management of user settings when taking on new staff or to
ensure existing staff have the same configuration set up across departments, with exception of the
Communication menu.

Payment Entry | Manual Cheque Book references
A Cheque Book reference option has been added to the Payment Entry menu. This new enhancement will allow
users to record a manual cheque book humber against a payment.

What's Better
An additional 10 enhancements have been included in this update. Please open the release notes and see page
10 for details on each enhancement.

Tag option in Tag Paid Invoices will now require a StrataMax Support password as it is no longer required
for day-to-day processes and prevents Bank Reconciliation and Payment Entry from working as designed if
used incorrectly.

StrataMax v5.6.30 @ Released 26th August 2021
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Security Setup | User Profile & Manager Account

The User Profile & Manager Account screen has received a user interface update, and when a new user is set up,
their email address and username will now be copied to the ‘Sender’ email address and ‘Username’ in the
Communication menu in Options > Communication Setup.

Financial Statements | Save Settings for Monthly Rollover

In the Financial Statements menu, a new item has been added in the Options menu called 'Save Settings for
Month End Rollover', which is to set the default financial statement to be stored when Month End Rollover is
completed.

Journal Preparation | Account Balances Display

A new field has been added to the Journal Preparation menu, which displays the current total and new total of
the account code for each line item in the journal set. The system will now calculate the impact of the
transaction on the selected account code, based on the amount you have entered.

Work Order Disbursements | TRMax Notes

When a job is issued in TaskMax and the charges have been set up in the Disbursements menu, a new record is
created in the TRMax menu. Enhancements have been made to the TRMax menu, which will now display an new
'‘Notes' field when quotes are requested and received and jobs are issued.

DocMax | Include Inactive Creditors
A new tick box has been added to DocMax when adding a new documents. Specifically under the 'Invoice
Details' section, which allows users to include Inactive Creditors from the Creditor drop-down menu.

What's Better
An additional 10 enhancements have been included in this update. Please open the release notes and see page
9 for details on each enhancement.

StrataMax v5.6.29 @ Released 12th August 2021

Marina Sub-Group | Levy Notices & Arrears Email Templates

Levy and Arrears notices in Marina Sub-groups will now utilise the local Levy or Arrears notice email template if
one has been set up.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement.

StrataMax v5.6.28 @ Released 29th July 2021

Payment Entry

A new Payment Entry menu has been added to provide a reliable platform to manage outgoing one-off
payments, reimbursements and part payments. This menu is designed as a replacement for the existing ‘Cheque
Entry’ process, allowing users to perform a number of different payment options (EFT, Cheque or BPAY).

Creditor Invoice | Save and Pay
In addition to the new Payment Entry menu, users can now access the Payment Entry menu via the Creditor
Invoices menu. This is used to pay a creditor immediately after the invoice is entered.

Bank Reconciliation | Create Payment
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In the Bank Reconciliation menu, in the Statement Entry/Processing tab, a new Create Payment button has been
added. This new option will replace the need to process directs to creditor accounts.

Edit Invoice List | Report to Excel
It is now possible to report and export information in the Edit Invoice List menu to Excel.

What's Better
An additional 8 enhancements have been included in this update. Please open the release notes and see page
35 for details on each enhancement.

StrataMax v5.6.27 @ Released 15th July 2021

Compliance Monitor | New Setting

The Compliance menu now has a new configuration setting which provides the option to include or exclude
inactive contractors.

Management Fee Setup | Cloning Option
The Management Fee Setup menu now has a new ‘Clone Fee’ button.

Roll Master Editor Menu | Agent/Mortgagee Contact Management

The Roll Master Editor menu has been updated with a new interface and functionality, and has been designed
from the ground up to enhance the user experience when adding, searching for, viewing, and editing property
agents and mortgagees in StrataMax. See the Roll Master Editor 5.6 article for more information.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page
11 for details on each enhancement.

StrataMax v5.6.26 @ Released 1st July 2021

Security - Reverse Presented Payments

A new security setting ‘Reverse Presented Payments’ has been added to the Security Setup menu. This will
control users and user groups from reversing presented payments via the Payments Management menu for
BCMax and GLMax.

Log Viewer - New Log Category - ArrNoticeClr

A new category has been added to the Log Viewer called ‘ArrNoticeClIr’, which will log a message when a receipt
has been made to an account in arrears if the ‘Clear Arrears Flag’ setting has been enabled in the Receipt Entry
menu in File > Configuration.

Restore Data | Support Only Function

Please be advised that in order to assure the integrity of your data, and stability and functionality of StrataMax,
we have restricted access to the Restore Data menu to only be available to the StrataMax Support team. This
decision has been made since a complete restore of an individual building can impact a lot of areas such as the
Bank Reconciliation, Invoice Hub, DocMax, Portal, and other areas, often causing further issues.

What's Better
An additional 8 enhancements have been included in this update. Please open the release notes and see page 6
for details on each enhancement.
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StrataMax v5.6.25 @ Released 17th June 2021

EFT Manager

EFT Manager has been enhanced to allow users to view payment details (including invoices and documents),
and can now also allow users to re-open a finalised batch under certain circumstances.

Month & Year End Rollover | New Auto-Rollover

A new option has been added to the Month / Year End Rollover menu configuration, which will automate the
rollover process if enabled. Rollovers will be completed in the background via a schedule, which can be
configured to skip or run based on the required criteria.

What's Better
An additional 16 enhancements have been included in this update. Please open the release notes and see page
13 for details on each enhancement.

StrataMax v5.6.24 @ Released 3rd June 2021

DocMax Building Prefill

The DocMax Auto prefill building option has been enhanced with more building type keywords. This will cater for
a broader range of building types.

Process Recoveries
The Process Recoveries module have been enhanced to include a new Invoice Code Filter which will allow
individual codes to be selected for processing.

EFT Manager & EFT Manager Report

Configurations have been added to the EFT Manager menu to allow users to set a default ‘DE User ID and User
Name’ for all banks except SCM.

The EFT Manager Report has been enhanced to report two (2) new fields of data.

Dashboard
The Management Dashboard has been enhanced to include a report titled ‘Arrears Budget Percentage’, and also
now includes two new reports.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page
15 for details on each enhancement.

StrataMax v5.6.23 @ Released 20th May 2021

Arrears Notices - Add a Ledger Card

Enhancements have been made to Arrears Notice Setup to allow for a Ledger Card to be added and output with
an Arrears Notice/Letter.

What's Better
An additional 11 enhancements have been included in this update. Please open the release notes and see page
7 for details on each enhancement.

StrataMax v5.6.22 @ Released 6th May 2021
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Communication Menu Enhancements
Enhancements have been made to the Communication menu to record the building number when emails have
been sent via StrataMax and provide the ability to search and filter by Building.

TaskMax | Bulk Finalise
Enhancements have been made to reduce the time restriction from 2 years to 1 year in the ‘Finalise Old Work
Orders’ menu option in TaskMax.

Management Fees Report
Improvements have been made to the Management Fees Report. Several new criteria have been added to the
setup for improved search speed and to prevent the search retrieving records for lost buildings.

DocMax | Add Documents | Auto Prefill Building setting
A new DocMax setting, ‘Auto Pre-fill Building’ has been added, which, when configured, will attempt to match the
document to a building in DocMax using keywords within the text of the document.

StrataMax v5.6.21 @ Released 22nd April 2021

Automatically Clear Arrears flag on receipt of funds

A new setting is now available in the Receipt Entry menu to ensure the arrears flags will be cleared automatically
when an owner payment is receipted and the account balance owing is zero or below the pre-configured
tolerance allowance.

What's Better
An additional 7 enhancements have been included in this update. Please open the release notes and see page 5
for details on each enhancement.

StrataMax v5.6.20 @ Released 8th April 2021
Dashboard Filter — by Management Office
The ability to filter by Management Office has been added to Dashboard Reports.

Lot Budget Summary — New Options
New configuration settings have been added to the Financial Statements menu to provide more output options
for consolidated reports when running the Lot Budget Summary report.

What's Better
An additional 9 enhancements have been included in this update. Please open the release notes and see page 7
for details on each enhancement.

StrataMax Version 5.5

StrataMax v5.5.113 @ Released 11th March 2021

Certificates - CERT205 QLD

CERT205 Certificate for relevant QLD buildings has been changed to reflect the most current version of the
regulatory act. The date will now show as ‘2020’

Meeting Hub
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The Document Distribution screen now displays a more obvious message when a meeting notice or minutes
have been sent. This message remains on screen until the Print/Email button is clicked again, or the Document
Distribution screen is closed.

StrataMax v5.5.110 @ Released 9th February 2021

Office Bearer Maintenance - ‘Nominated By Lot’ Field

A new field called ‘Nominated By Lot has been added to the Office Bearers menu to record the details of the lot
owner that nominated the committee member. The reason is to comply with changes made to Body Corporate
and Community Management (Standard Module) Regulations 2020 (i.e. building types B.F.P, S.F.P and V.P),
which take effect 1st March 2021.

StrataMax v5.5.109 @ Released 27th January 2021

Office Bearer Maintenance - ‘Nominated By Lot’ Field

A new field called ‘Nominated By Lot" has been added to the Office Bearers menu to record the details of the lot
owner that nominated the committee member. The reason is to comply with changes made to Body Corporate
and Community Management (Standard Module) Regulations 2020 (i.e. building types B.F.P, S.F.P and V.P),
which take effect 1st March 2021.

StrataMax v5.5.107 @ Released 9th December 2020

Resubdivision - Old Process

The old Resubdivision process has now been completely removed from StrataMax. Now when in the Roll menu,
clicking the Edit or New buttons in the Entitlements/Contribution or Interest tabs, will automatically open the new
Resubdivision menu.

StrataMax v5.5.106 @ Released 25th November 2020

Financial Statements - Proposed Budget with Footnotes

Two new Proposed Budget Templates have been added to Financial Statements to provide the facility to add
Footnotes to Proposed Budget reports.

Roll Confirmation Template with Delivery Preferences
A new Roll Details Confirmation template called ‘Roll Details Confirmation - Mailroom Auto Populate’ has been
added which will show the Levy Notice and Correspondence preferences as set in the Roll menu.

StrataMax v5.5.105 & Released 11th November 2020

Unpaid Creditor Invoice Report

The Unpaid Creditor Invoice Report has been enhanced with a new user interface and selection functions for
users to apply more refined selections making report results more selective.

StrataMax v5.5.104 @ Released 28th October 2020
Certificates
The Certificate for building type ‘UP’ - ACT Unit Titles Management has been updated, and the WA Certificate
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layout has been enhanced to incorporate levy data in the Certificate and is no longer included as an Annexure.

Banking
Three new options have been added to the Special Legend in the Bank Rec screen.

StrataMax v5.5.100 & Released 9th September 2020

Meeting Hub

Email functionality has been enhanced to allow for the inclusion of a tailored subject and body in Emails sent
from Meeting Hub/ Document Distribution.

New Security Permissions to be setup - 'Meeting Hub (Email Template Setup)'.

StrataMax v5.5.99 @ Released 26th August 2020

StrataMax

A new Resubdivision/Reallocation of Entitlements module has been added to StrataMax to simplify the process
of a Resubdivision and amending existing lot entitlements. This new process provides step-by-step setup
screens for entry of data and reporting to confirm the validity of input prior to processing.

New Security Permissions to be setup - 'Roll (Resubdivision / Reallocation of entitlements)'.

StrataMax v5.5.96 @ Released 12th August 2020

Meeting Hub

Additional settings to allow distribution of meeting notices & minutes to exclude lots with 0 entitlements and
remove duplicates based on the recipients address.

StrataMax v5.5.95 @ Released 29th July 2020

StrataMax

Discount transactions in various reports will now display the Discount Invoice Code Description to make it easier
to identify the fund the discount applies to.

StrataMax v5.5.94 @ Released 15th July 2020

Meeting Hub

Standard Meetings, Agenda Items and Motions have been enhanced to allow DocMax documents of the type
‘Internal Document’ to be attached. This would be useful for documents such as Proxy & Nominee forms etc.

StrataMax v5.5.93 @ Released 1st July 2020

StrataMax

User Interface changes to Transaction Report Manager which is used to select certain transactions that you do
not wish to display on reports.

StrataMax v5.5.92 @ Released 17th June 2020

StrataMax

Generated levies are now able to be edited therefore in particular scenarios users will no longer need to reverse
alevy.

New Security Permissions to be setup - 'Levies (Edit generated levies)'.
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